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PIC16F18076 Curiosity Nano Hardware User Guide

Preface

The PIC16F18076 Curiosity Nano evaluation kit (EV53Z50A) is a hardware platform to evaluate the PIC16F18076
family microcontrollers. This board has the PIC16F 18076 microcontroller (MCU) mounted.

Supported by MPLAB® X IDE, the board provides easy access to the features of the PIC16F 18076 to explore how to
integrate the device into a custom design.

The Curiosity Nano series of evaluation boards include an on-board debugger. No external tools are necessary to
program and debug the PIC16F18076.

+ MPLAB® X IDE - Software to discover, configure, develop, program, and debug Microchip microcontrollers.
* Code examples on GitHub - Get started with code examples.

* PIC16F18076 website - Find documentation, data sheets, sample, and purchase microcontrollers.

» PIC16F18076 Curiosity Nano website - Kit information, latest user guide and design documentation.
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Introduction

1. Introduction

11 Features
» PIC16F18076 Microcontroller
* One Yellow User LED
* One Mechanical User Switch
* One 32.768 kHz Crystal
* On-Board Debugger:
— Board identification in Microchip MPLAB® X IDE
— One green power and status LED
— Programming and debugging
Virtual serial port (CDC)
One debug GPIO channel (DGI GPIO)
» USB Powered
* Adjustable Target Voltage:
— MIC5353 LDO regulator controlled by the on-board debugger
— 1.8-5.1V output voltage (limited by USB input voltage)
— 500 mA maximum output current (limited by ambient temperature and output voltage)

1.2 Board Overview
The Microchip PIC16F18076 Curiosity Nano evaluation kit is a hardware platform to evaluate the PIC16F 18076
microcontroller.
Figure 1-1. PIC16F18076 Curiosity Nano Board Overview
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Getting Started

Getting Started

Curiosity Nano Quick Start MPLAB® Xpress

MPLAB Xpress Cloud-Based IDE is part of the MPLAB Cloud tools ecosystem, leveraging the intuitive MPLAB
Discover for finding projects and code examples and the MPLAB Code Configurator graphical configuration tool to
provide an all-in cloud experience.

Steps to start exploring the Curiosity Nano platform with MPLAB Xpress:

1. Go to www.mplab-xpresside.microchip.com/ to open MPLAB Xpress.
Create a new standalone project for PIC16F18076.
Use the MPLAB Xpress Code Configurator, or write your code.
Compile and download the application HEX file.

Connect a USB cable (Standard-A to Micro-B or Micro-AB) between the PC and the debug USB port on the
board.

6. Copy the application HEX file into the CURIOSITY mass storage drive to program the application into the
PIC16F18076.

To use the advanced debug features of the Curiosity Nano kit, package the MPLAB Xpress project for MPLAB
X IDE, and follow the quick start guide in the next section.

ok~ wbd

Quick Start

Steps to start exploring the PIC16F 18076 Curiosity Nano board:
1.  Download Microchip MPLAB® X IDE.
Download MPLAB® XC C Compiler.
Launch MPLAB® X IDE.
Optional: Use MPLAB® Code Configurator to generate drivers and examples.
Write\Develop the application code.

Connect a USB cable (Standard-A to Micro-B or Micro-AB) between the PC and the debug USB port on the
board.

7. Program your application onto the device.

The PIC16F 18076 device on the PIC16F18076 Curiosity Nano board is programmed and debugged by the
on-board debugger. Therefore, no external programmer or debugger tool is required.

o ok whN

Driver Installation
When the board connects to the computer for the first time, the operating system will perform a driver software

installation. The driver file supports both 32- and 64-bit versions of Microsoft® Windows®. The drivers for the board
are included with MPLAB® X IDE.

Kit Window
When the board is connected to a computer and powered on, the green status LED will be lit, the MPLAB® X IDE will

auto-detect which boards are connected. The Kit Window in MPLAB® X IDE will present relevant information like data
sheets and board documentation.

Tip: If closed, reopen the Kit Window in MPLAB® X IDE through the menu bar Window > Kit Window.
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MPLAB® X IDE Device Family Packs

Microchip MPLAB® X IDE requires specific information to support devices and tools. This information is contained

in versioned packs. For the PIC16F18076 Curiosity Nano board, MPLAB® X version 6.0 or later with device family
pack “PIC16F 1xxxx_DFP” version 1.14.187 or later and tool pack “nEDBG_TP” version 1.10.488 or later or newer is
required. For more information on packs and how to upgrade them, refer to the MPLAB® X IDE User’s guide - Work
with Device Packs.

Tip: The latest device family packs are available through Tools > Packs in MPLAB® X IDE or online at
Microchip MPLAB® X Packs Repository.

Design Documentation and Relevant Links

The following list contains links to the most relevant documents and software for the PIC16F18076 Curiosity Nano
board:

+ MPLAB® X IDE - MPLAB X IDE is a software program that runs on a PC (Windows®, Mac OS®, Linux®)
to develop applications for Microchip microcontrollers and digital signal controllers. It is named an Integrated
Development Environment (IDE) because it provides a single integrated “environment” to develop code for
embedded microcontrollers.

+ MPLAB® XC Compilers - MPLAB® XC8 C Compiler is available as a free, unrestricted-use download.
Microchips MPLAB® XC8 C Compiler is a comprehensive solution for the project’s software development on
Windows®, macOS® or Linux®. MPLAB® XC8 supports all 8-bit PIC® and AVR® microcontrollers (MCUs).

+ MPLAB® Xpress Cloud-Based IDE - MPLAB Xpress Cloud-Based IDE is an online development environment
containing the most popular features of our award-winning MPLAB X IDE. This simplified and distilled
application is a faithful reproduction of our desktop-based program, allowing users an easy transition between
the two environments.

+ MPLAB® Code Configurator - MPLAB Code Configurator (MCC) is a free software plug-in that provides a
graphical interface to configure peripherals and functions specific to your application.

» Microchip Sample Store - Microchip sample store where one can order samples of devices.

* MPLAB Data Visualizer - MPLAB Data Visualizer is a program used for processing and visualizing data. The
Data Visualizer can receive data from various sources, such as serial ports and the on-board debugger’s Data
Gateway Interface, as found on Curiosity Nano and Xplained Pro boards.

» MPLAB Discover - MPLAB Discover is a tool to help you find Microchip example projects and collateral for
Microchip devices.

» PIC16F18076 Curiosity Nano website - Kit information, latest user guide and design documentation.

* PIC16F18076 Curiosity Nano on Microchip Direct - Purchase this kit on Microchip Direct.
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Curiosity Nano

Curiosity Nano is an evaluation platform of small boards with low pin count microcontroller (MCU) boards with
on-board debuggers and access to most microcontrollers 1/0s. The Curiosity Nano platform offers easy integration
with MPLAB® X IDE. All boards are identified in the IDE. When connected, a Kit Window appears with links to key
documentation, including relevant user guides, application notes, data sheets, and example code. Everything is easy
to find. The on-board debugger features a virtual serial port (CDC) for serial communication to a host PC and a Data
Gateway Interface (DGI) with debug GPIO pin(s).

On-Board Debugger Overview
PIC16F18076 Curiosity Nano contains an on-board debugger for programming and debugging. The on-board
debugger is a composite USB device consisting of several interfaces:

+ A debugger that can program and debug the PIC16F18076 in MPLAB® X IDE

* A mass storage device that allows drag-and-drop programming of the PIC16F18076

» A virtual serial port (CDC) that is connected to a Universal Asynchronous Receiver/Transmitter (UART) on the
PIC16F18076 and provides an easy way to communicate with the target application through terminal software

« A Data Gateway Interface (DGI) for code instrumentation with logic analyzer channels (debug GPIO) to visualize
program flow

The on-board debugger controls a Power and Status LED (marked PS) on the PIC16F18076 Curiosity Nano board.
The table below shows how the different operation modes control the LED.

Table 3-1. On-Board Debugger LED Control

Operation Mode Power and Status LED

Boot Loader mode The LED blinks slowly during power-up

Power-up The LED is ON

Normal operation The LED is ON

Programming Activity indicator: The LED blinks slowly during programming/debugging

Drag-and-drop

) Success: The LED blinks slowly for 2 sec.
programming
Failure: The LED blinks rapidly for 2 sec.
Fault The LED blinks rapidly if a power fault is detected
Sleep/Off The LED is OFF. The on-board debugger is either in a sleep mode or powered down.

This can occur if the board is externally powered.

ﬂ Info: Slow blinking is approximately 1 Hz, and rapid blinking is about 5 Hz.

Debugger

The on-board debugger on the PIC16F18076 Curiosity Nano board appears as a Human Interface Device (HID)
on the host computer’s USB subsystem. The debugger supports full-featured programming and debugging of the
PIC16F 18076 by using MPLAB X IDE.
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Remember: Keep the debugger’s firmware up-to-date. Firmware upgrades automatically when using
i MPLAB X IDE.

31.2 Virtual Serial Port (CDC)
The virtual serial port (CDC) is a general purpose serial bridge between a host PC and a target device.

3.1.21 Overview
The on-board debugger implements a composite USB device with a standard Communications Device Class (CDC)
interface, which appears on the host as a virtual serial port. Use the CDC to stream arbitrary data between the host
computer and the target in both directions: All characters sent through the virtual serial port on the host computer will
be transmitted as UART on the debugger’s CDC TX pin. The UART characters captured on the debugger’'s CDC RX
pin will be returned to the host computer through the virtual serial port.

Figure 3-1. CDC Connection

PC Terminal Debugger Target Target DSC
. Send Recei
Software < Terminal Target
Receive Send
Info: The debugger’s CDC TX pin is connected to a UART RX pin on the target for receiving characters
from the host computer, as shown in the figure above. Similarly, the debugger’s CDC RX pin is connected
to a UART TX pin on the target for transmitting characters to the host computer.

3.1.2.2 Operating System Support

On Windows® machines, the CDC will enumerate as Curiosity Virtual COM Port and appear in the Ports section of
the Windows Device Manager. The COM port number can also be found there.

Info: On older Windows systems, the CDC requires a USB driver. The MPLAB X IDE installationinclude
this driver.

On Linux® machines, the CDC will enumerate and appear as /dev/ttyACM#.
that group to have permission to access the CDC.

ﬂ Info: tty* devices belong to the “dialout” group in Linux, so it may be necessary to become a member of

On Mac® machines, the CDC will enumerate and appear as /dev/tty.usbmodem#. Depending on the terminal
program used, it will appear in the available list of modems as usbmodem#.
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Info: For all operating systems, use a terminal emulator that supports DTR signaling. See
3.1.2.4. Signaling.

3.1.2.3 Limitations
Not all UART features are implemented in the on-board debugger CDC. The constraints are outlined here:

» Baud rate: Must be in the range of 1200 bps to 500 kbps. Any baud rate outside this range will be set to the
closest limit without warning. Baud rate can be changed on-the-fly.

» Character format: Only 8-bit characters are supported.
» Parity: Can be odd, even, or none.

» Hardware flow control: Not supported.

» Stop bits: One or two bits are supported.

3.1.2.4 Signaling
During USB enumeration, the host OS will start both the communication and data pipes of the CDC interface. At this
point, it is possible to set and read back the baud rate and other UART parameters of the CDC, but data sending and
receiving will not be enabled.

The terminal must assert the DTR signal when it connects to the host. As this is a virtual control signal implemented
on the USB interface, it is not physically present on the board. Asserting the DTR signal from the host will indicate to
the on-board debugger that a CDC session is active. The debugger will enable its level shifters (if available) and start
the CDC data send and receive mechanisms.

Deasserting DTR in debugger firmware version 1.20 or earlier has the following behavior:
» Debugger UART receiver is disabled, and no further data will be transferred to the host computer

» Debugger UART transmitter will continue to send queued data ready for transfer, but no new data is accepted
from the host computer

» Level shifters (if available) are not disabled, and the debugger CDC TX line remains driven

Deasserting DTR in debugger firmware version 1.21 or later has the following behavior:
» Debugger UART receiver is disabled, and no further data will be transferred to the host computer
« Debugger UART transmitter will continue to send queued data ready for transfer, but no new data is accepted
from the host computer
* Once the ongoing transmission is complete, level shifters (if available) are disabled, and the debugger CDC TX
line will become high-impedance

Remember: Set up the terminal emulator to assert the DTR signal. Without the signal, the on-board
['__ ¥ debugger will not send or receive data through its UART.

Tip: The on-board debugger’s CDC TX pin will not be driven until the CDC interface is enabled by the
host computer. Also, there are no external pull-up resistors on the CDC lines connecting the debugger
and the target, which means that the lines are floating during power-up. The target device may enable the
internal pull-up resistor on the pin connected to the debugger’s CDC TX pin to avoid glitches resulting in
unpredictable behavior like framing errors.

© 2023 Microchip Technology Inc. User Guide DS50003399B-page 8
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Advanced Use

CDC Override Mode

In ordinary operation, the on-board debugger is a true UART bridge between the host and the device. However, in
certain use cases, the on-board debugger can override the basic Operating mode and use the CDC TX and RX pins
for other purposes.

Dropping a text file into the on-board debugger’s mass storage drive can be used to send characters out of the
debugger’s CDC TX pin. The filename and extension are trivial, but the text file will start with the characters:

CMD: SEND UART=

Debugger firmware version 1.20 or earlier has the following limitations:
» The maximum message length is 50 characters — all remaining data in the frame are ignored

» The default baud rate used in this mode is 9600 bps, but if the CDC is already active or configured, the
previously used baud rate still applies

Debugger firmware version 1.21 and later has the following limitations/features:
» The maximum message length will vary depending on the MSC/SCSI layer timeouts on the host computer
and/or operating system. A single SCSI frame of 512 bytes (498 characters of payload) is ensured, and files up
to 4 KB will work on most systems. The transfer will complete on the first NULL character encountered in the file.

» The baud rate used is always 9600 bps for the default command:

CMD: SEND UART=

* Do not use the CDC Override mode simultaneously with data transfer over the CDC/terminal. If a CDC terminal
session is active when receiving a file via the CDC Override mode, it will be suspended for the duration of the
operation and resumed once complete.

* Additional commands are supported with explicit baud rates:
CMD: SEND_9600=

CMD:SEND_115200=

CMD: SEND_460800=

USB-Level Framing Considerations

Sending data from the host to the CDC can be done byte-wise or in blocks, chunked into 64-byte USB frames. Each
frame will be queued for transfer to the debugger’s CDC TX pin. Sending a small amount of data per frame can

be inefficient, particularly at low baud rates, as the on-board debugger buffers frames but not bytes. A maximum of

four 64-byte frames can be active at any time. The on-board debugger will throttle the incoming frames accordingly.
Sending full 64-byte frames containing data is the most efficient method.

When receiving data on the debugger’s CDC RX pin, the on-board debugger will queue up the incoming bytes into
64-byte frames, which are sent to the USB queue for transmission to the host when they are full. Incomplete frames
are also pushed to the USB queue at approximately 100 ms intervals, triggered by USB start-of-frame tokens. Up to
eight 64-byte frames can be active at any time.

An overrun will occur if the host (or the software running on it) fails to receive data fast enough. When this happens,
the last-filled buffer frame recycles instead of being sent to the USB queue, and a complete data frame will be lost. To
prevent this occurrence, the user will ensure that the CDC data pipe is continuously read, or the incoming data rate
will be reduced.

Sending Break Characters
The host can send a UART break character to the device using the CDC, which can be useable for resetting a
receiver state-machine or signalling an exception condition from the host to the application running on the device.

A break character is defined as a sequence of at least 11 zero bits transmitted from the host to the device.

Not all UART receivers have support for detecting a break, but a correctly-formed break character usually triggers a
framing error on the receiver.

© 2023 Microchip Technology Inc. User Guide DS50003399B-page 9
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Sending a break character using the debugger's CDC has the following limitations:

« Sending a break must NOT be done simultaneously as using the CDC Override mode (drag-and-drop). Both
these functions are temporary states, so they must be used independently.

» Sending a break will cause data currently being sent to be lost. Be sure to wait a sufficient amount of time to
allow all characters in the transmission buffer to be sent (see above section) before sending the break, which
is also in line with expected break character usage: For example, reset a receiver state-machine after a timeout
occurs waiting for data to be returned to the host.

» The CDC specification allows for debugger-timed breaks of up to 65534ms in duration to be requested. For
simplicity, the debugger will limit the break duration to maximum 11 bit-durations at its minimum supported baud
rate.

» The CDC specification allows for indefinite host-timed breaks. It is the responsibility of the terminal application/
user to release the break state in this case.

Note: Sending break characters is available in debugger firmware version 1.24 and later.

313 Mass Storage Device
The on-board debugger includes a simple Mass Storage Device implementation, which is accessible for read/write
operations via the host operating system to which it is connected.
It provides:
» Read access to basic text and HTML files for detailed kit information and support
+  Write access for programming Intel® HEX formatted files into the target device’s memory
» Write access for simple text files for utility purposes

3.1.3.1  Mass Storage Device Implementation
The on-board debugger implements a highly optimized variant of the FAT12 file system with several limitations, partly
due to the nature of FAT12 itself and optimizations made to fulfill its purpose for its embedded application.

The Curiosity Nano USB device is USB Chapter 9-compliant as a mass storage device but does not, in any way, fulfill
the expectations of a general purpose mass storage device. This behavior is intentional.

When using the Windows operating system, the on-board debugger enumerates as a Curiosity Nano USB Device
found in the disk drives section of the device manager. The CURIOSITY drive appears in the file manager and claims
the following available drive letter in the system.

The CURIOSITY drive contains approximately one MB of free space and does not reflect the target device’s Flash
size. When programming an Intel HEX file, the binary data are encoded in ASCII with metadata providing a large
overhead, so 1 MB is a trivially chosen value for disk size.

It is not possible to format the CURIOSITY drive. The filename may appear in the disk directory listing when
programming a file to the target, which is merely the operating system’s view of the directory that, in reality, has not
been updated. It is not possible to read out the file contents. Removing and replugging the board will return the file
system to its original state, but the target will still contain the previously programmed application.

Copy a text file starting with “CMD: ERASE” onto the disk to erase the target device.

By default, the CURIOSITY drive contains several read-only files for generating icons as well as reporting status and
linking to further information:

* AUTORUN. ICO —icon file for the Microchip logo

* AUTORUN. INF — system file required for Windows Explorer to show the icon file

* KIT-INFO.HTM — redirect to the development board website

* KIT-INFO.TXT — a text file containing details about the board’s debugger firmware version, board name, USB
serial number, device, and drag-and-drop support

* STATUS.TXT — a text file containing the programming status of the board

Info: The on-board debugger dynamically updates STATUS . TXT. The contents may be cached by the OS
and, therefore, may not reflect the correct status.
© 2023 Microchip Technology Inc. User Guide DS50003399B-page 10
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3.1.3.2 Special Commands

Several utility commands are supported by copying text files to the mass storage disk. The filename or extension is
irrelevant — the command handler reacts to content only.

Table 3-2. Special File Commands

CMD:ERASE Executes a chip erase of the target

CMD: SEND UART= Sends a string of characters to the CDC UART. See “CDC
Override Mode.”

CMD:SEND_9600= Sends a string of characters to the CDC UART at the specified

CMD:SEND 115200= baud rate. Note that only the baud rates explicitly specified here

CMD:SEND 460800= are supported. See “CDC Override Mode.” (Debugger firmware

v1.25.6 or newer.)

CMD:RESET Resets the target device by entering Programming mode and
exiting Programming mode immediately afterward. The exact
timing can vary according to the programming interface of the
target device. (Debugger firmware v1.25.6 or newer.)

CMD: POWERTOGGLE Powers down the target and restores it after a 100 ms delay.
If external power is provided, this has no effect. (Debugger
firmware v1.25.6 or newer.)

CMD: 0V Powers down the target device by disabling the target supply
regulator. If external power is provided, this has no effect.
(Debugger firmware v1.25.6 or newer.)

CMD:1V8 Sets the target voltage to 1.8V. If external power is provided,
this has no effect. (Debugger firmware v1.25.6 or newer.)

CMD: 3V3 Sets the target voltage to 3.3V. If external power is provided,
this has no effect. (Debugger firmware v1.25.6 or newer.)

Info: The content sent to the mass storage emulated disk triggers the commands listed here and provides
no feedback in the case of either success or failure.

314 Data Gateway Interface (DGI)
Data Gateway Interface (DGI) is a USB interface transporting raw and timestamped data between on-board
debuggers and host computer-based visualization tools. MPLAB Data Visualizer is used on the host computer to
display any debug GPIO data. It is available as a plug-in for MPLAB X IDE or a stand-alone application that can be
used in parallel with MPLAB® X IDE.

Although DGI encompasses several physical data interfaces, the PIC16F18076 Curiosity Nano implementation
includes logic analyzer channels:

* One debug GPIO channel (also known as DGI GPIO)

3.1.41 Debug GPIO
Debug GPIO channels are timestamped digital signal lines connecting the target application to a host computer
visualization application. They are typically used to plot low-frequency events on a time axis, such as when given
Application state transitions occur.

The figure below shows the monitoring of the Digital state of a mechanical switch connected to a debug GPIO in
MPLAB Data Visualizer.

© 2023 Microchip Technology Inc. User Guide DS500033998B-page 11
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Figure 3-2. Monitoring Debug GPIO with MPLAB Data Visualizer
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Debug GPIO channels are timestamped, so the resolution of DGI GPIO events is determined by the resolution of the
DGI Timestamp module.

Important: Although signal bursts of higher frequency can be captured, the frequency range of signals for
which debug GPIO can be used is up to about 2 kHz. Attempting to capture signals above this frequency
will result in data saturation and overflow, which may cause the DGI session to be aborted.

Timestamping
When captured by the debugger, DGI sources are timestamped. The timestamp counter implemented in the Curiosity
Nano debugger increments at a 2 MHz frequency, providing a timestamp resolution of a half microsecond.

Curiosity Nano Standard Pinout

The 12-edge connections closest to the USB connector on Curiosity Nano boards have a standardized pinout. The
program/debug pins have different functions depending on the target programming interface, as shown in the table
and figure below.

Table 3-3. Curiosity Nano Standard Pinout

ID — ID line for extensions
CDC TX UART RX USB CDC TX line
CDC RX UART TX USB CDC RX line
DBGO ICSPDAT Debug data line
DBG1 ICSPCLK Debug clock line
DBG2 GPIO0 Debug GPIO0
DBG3 MCLR Reset line
NC — No connect
© 2023 Microchip Technology Inc. User Guide DS50003399B-page 12
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........... continued

Vgus — Vpys Vvoltage for external use

VOFF — Voltage Off input. Disables the target regulator and
target voltage when pulled low.

VTG — Target voltage

GND — Common ground

Figure 3-3. Curiosity Nano Standard Pinout

DEBUGGER

[ DBG2 D—® CcuRiOSITYNANO @—CGem VTG ]

Power Supply

The USB port powers the board. It contains two LDO regulators, one to generate 3.3V for the on-board debugger and
an adjustable LDO regulator for the target PIC16F18076 microcontroller and its peripherals. The voltage from a USB

connector can vary between 4.4V and 5.25V (according to the USB specification) and will limit the maximum voltage

supplied to the target. The figure below shows the entire power supply system on PIC16F18076 Curiosity Nano.

o»

Figure 3-4. Power Supply Block Diagram

V, Power Target
| Target REG VIVL ol corny L Power
Regulator strap strap

A
Vuss i_On/off
UsSB > Adjust
. Power consumer v DEBUGGER | P3V3 GPIO I/0
—P> DEBUGGER Wi
I:I Power converter EJSc; Regulator straps

I:l Power protection
|:| Power source

|:| Cut strap
BUS

Target Regulator

The target voltage regulator is a MIC5353 variable output LDO. The on-board debugger can adjust the voltage output
supplied to the board target section by manipulating the MIC5353’s feedback voltage. The hardware implementation
is limited to an approximate voltage range from 1.7V to 5.1V. Additional output voltage limits are configured in
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the debugger firmware to ensure that the output voltage never exceeds the hardware limits of the PIC16F18076
microcontroller. The voltage limits configured in the on-board debugger on PIC16F18076 Curiosity Nano are 1.8—
5.5V.

properties. Any change to the target voltage is persistent, even after a power toggle. The resolution is less

n Info: The factory default target voltage is 3.3V. It can be changed through the MPLAB® X IDE project
than 5 mV but may be limited to 10 mV by the adjustment program.

voltage setting is applied to the board when accessing the debugger, like pushing the Refresh Debug Tool

ﬂ Info: The voltage settings setup in MPLAB® X IDE is not applied immediately to the board. The new
Status button in the project dashboard tab or programming/reading program memory.

Info: There is an easy option to adjust the target voltage with a drag-and-drop command text file to the
board, which supports a set of mutual target voltages. See section 3.1.3.2. Special Commands for further
details.

MIC5353 supports a maximum current load of 500 mA. It is an LDO regulator in a small package placed on a small
printed circuit board (PCB), and the thermal shutdown condition can be reached at lower loads than 500 mA. The
maximum current load depends on the input voltage, the selected output voltage, and the ambient temperature.
The figure below shows the safe operating area for the regulator, with an input voltage of 5.1V and an ambient
temperature of 23°C.

Figure 3-5. Target Regulator Safe Operation Area
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The voltage output of the target regulator is continuously monitored (measured) by the on-board debugger. An error
condition will be flagged, and the target voltage regulator will be switched off, detecting and handling any short-circuit
conditions if it is more than 100 mV over/under the set device voltage. It will also detect and handle if an external
voltage, which causes Vcc_TARGET to move outside the voltage setting monitoring window of £100 mV, is suddenly
applied to the VTG pin without setting the Vorg pin low.
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blink rapidly if the external voltage is under this limit. The on-board debugger status LED will continue to
shine if the external voltage surpasses this limit. When removing the external voltage, the status LED will
start blinking rapidly until the on-board debugger detects the new situation and turns the target voltage
regulator back on.

ﬂ Info: The on-board debugger has a monitoring window of Voc_ TARGET%100 mV, and the status LED will

External Supply

Instead of the on-board target regulator, an external voltage can power the PIC16F18076 Curiosity Nano. When
shorting the Voltage Off (VOFF) pin to the ground (GND) pin, the on-board debugger firmware disables the target
regulator, and it is safe to apply an external voltage to the VTG pin.

It is also safe to apply an external voltage to the VTG pin when no USB cable is plugged into the DEBUG connector
on the board.

The VOFF pin can be tied low/let go at any time, which will be detected by a pin-change interrupt to the on-board
debugger, which controls the target voltage regulator accordingly.

Applying an external voltage to the VTG pin without shorting VOFF to GND may cause permanent damage

AWARNING to the board.

/AWARNING Do not apply any voltage to the VOFF pin. Let the pin float to enable the power supply.

The absolute maximum external voltage is 5.5V for the on-board level shifters, and the standard operating

AWARNING condition of the PIC16F 18076 is 1.8—-5.5V. Applying a higher voltage may cause permanent damage to the
board.
Info: The on-board debugger status LED will blink rapidly and shut the on-board regulator off when
applying an external voltage without pulling the VOFF pin low - and an external supply pulls the voltage
lower than the monitoring window’s lower limit (target voltage setting — 100 mV). The status LED starts

blinking rapidly until the on-board debugger detects the new situation and switches the target voltage
regulator back on if suddenly removing an external voltage when the VOFF pin is not pulled low.

Programming, debugging, and data streaming are still possible with an external power supply. The USB cable will
power the debugger and signal level shifters. Both regulators, the debugger, and the level shifters are powered down
when the USB cable is removed.

will be drawn from any external power source to power the on-board level shifters and voltage monitor
circuitry when a USB cable is plugged into the DEBUG connector on the board. When a USB cable is
unplugged, some current is used to supply the level shifter’s voltage pins, which have a worst-case current
consumption of approximately 5 yA. Typical values may be as low as 100 nA.

ﬂ Info: In addition to the power consumed by the PIC16F18076 and its peripherals, approximately 100 yA

VBUS Output Pin

PIC16F18076 Curiosity Nano has a VBUS output pin that can be used to power external components that need a 5V
supply. The VBUS output pin has a PTC fuse to protect the USB against short circuits. A side effect of the PTC fuse
is a voltage drop on the VBUS output with higher current loads. The chart below shows the voltage versus the current
load of the VBUS output.
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Figure 3-6. VBUS Output Voltage vs. Current
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Power Supply Exceptions
This section sums up most exceptions that can occur with the power supply.

Target Voltage Shuts Down

Not reaching the target voltage setting can happen if the target section draws too much current at a given voltage and
cause the thermal shutdown safety feature of the MIC5353 regulator to kick in. To avoid this, reduce the current load
of the target section.

Target Voltage Setting is Not Reached

The USB input voltage (specified to be 4.4V-5.25V) limits the maximum output voltage of the MIC5353 regulator at a
given voltage setting and current consumption. If a higher output voltage is needed, use a USB power source with a
higher input voltage or use an external voltage supply on the VTG pin.

Target Voltage is Different From Setting

An externally applied voltage to the VTG pin without setting the VOFF pin low can cause this. If the target voltage
differs more than 100 mV over/under the voltage setting, the on-board debugger will detect it, and the internal voltage
regulator will shut down. To fix this issue, remove the applied voltage from the VTG pin, and the on-board debugger
will enable the on-board voltage regulator when the new condition is detected. Note that the PS LED will blink rapidly
if the target voltage is below 100 mV of the setting but will ordinarily turn on when higher than 100 mV above it.

No, Or Very Low Target Voltage, and PS LED is Blinking Rapidly
A full or partial short circuit can cause this and is a particular case of the issue above. Remove it, and the on-board
debugger will re-enable the on-board target voltage regulator.
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No Target Voltage and PS LED is Lit 1
This situation occurs if the target voltage is set to 0.0V. Set the target voltage to a value within the specified voltage
range for the target device to fix this.

No Target Voltage and PS LED is Lit 2

This situation can be the issue if power jumper J100 and/or J101 are cut, and the target voltage regulator is set to

a value within the specified voltage range for the target device. To fix this, solder a wire/bridge between the pads for
J100/J101, or add a jumper on J101 if a pin-header is mounted.

Vgys Output Voltage is Low or Not Present

If the VBUS output voltage is low or missing, the reason is probably a high-current drain on Vgys, and the protection
fuse (PTC) will reduce the current or cut off completely. Reduce the current consumption on the VBUS pin to fix this
issue.

Low-Power Measurement
Power to the PIC16F18076 is connected from the on-board power supply and VTG pin through a 100 mil pin-header
marked with “POWER” in silkscreen (J101). To measure the power consumption of the PIC16F18076 and other
peripherals connected to the board, cut the Target Power strap and connect an ammeter over it.
To measure the lowest possible power consumption, follow these steps:
1. Cut the POWER strap with a sharp tool.
2. Solder a 1x2 100 mil pin-header in the footprint.
3. Connect an ammeter to the pin header.
4. Write firmware that:
a. Tri-states any I/O connected to the on-board debugger.
b.  Sets the microcontroller in its lowest Power sleep mode.
5. Program the firmware into the PIC16F18076.

Figure 3-7. Target Power Strap

Cl'arget Power strap (top side)
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Tip: A 100-mil pin-header can be soldered into the Target Power strap (J101) footprint for a simple
connection of an ammeter. Place a jumper cap on the pin-header once the ammeter is no longer needed.

MA can be drawn from each 1/O pin connected to a level shifter. Therefore, the worst-case maximum for
the five on-board level shifters is 10 yA. Keep any 1/O pin connected to a level shifter in the tri-state to
prevent leakage. All I/Os connected to the on-board debugger are listed in 4.2.4.1. On-Board Debugger
Connections. The on-board level shifters can be completely disconnected to prevent leakage, as described
in 7.4. Disconnecting the On-Board Debugger.

n Info: The on-board level shifters will draw a small amount of current even when not used. Maximum 2

Programming External Microcontrollers

Use the on-board debugger on PIC16F 18076 Curiosity Nano to program and debug microcontrollers on external
hardware.

Supported Devices
All external AVR microcontrollers with the UPDI interface can be programmed and debugged with the on-board
debugger with Microchip Studio.

External SAM microcontrollers having a Curiosity Nano Board can be programmed and debugged with the on-board
debugger with Microchip Studio.

PIC16F18076 Curiosity Nano can program and debug external PIC16F18076 microcontrollers with MPLAB X IDE.

Software Configuration
No software configuration is required to program and debug the same device mounted on the board.
To program and debug a different microcontroller than the one mounted on the board, configure Microchip Studio to
allow an independent selection of devices and programming interfaces.
1. Navigate to Tools > Options through the menu system at the application top.
2. Select the Tools > Tool settings category in the options window.
3. Set the Hide unsupported devices option to False.
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Figure 3-8. Hide Unsupported Devices

Options
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Environment
Projects
Source Control
Text Editor
Debugger
Atmel Start
Atmel Studio Feedback
Builder
Device and Tool libraries
Extensions
Programming Dialog
Status Management
Toolchain
Tools

Tool settings
KAML Designer

v Tool settings

Automatically pick a tool True
Check firmware True
Custom pregramming tool default ti 60

Enable diagnostic logging True

Hide unsupported devices False

Mask interrupts while stepping True
Hide unsupported devices

Hide devices that are not qualified for use with the current tool.

Hardware Modifications

Info: Microchip Studio allows any microcontroller and interface to be selected when the Hide
unsupported devices setting is set to False - also microcontrollers and interfaces not supported by
the on-board debugger.

The on-board debugger is connected to the PIC16F18076 by default. Remove these connections before any external
microcontroller can be programmed or debugged. Cut the GPIO straps shown in the figure below with a sharp tool to
disconnect the PIC16F 18076 from the on-board debugger.
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Figure 3-9. Programming and Debugging Connections to Debugger
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Info: Cutting the connections to the debugger will disable programming, debugging, and data streaming
from the PIC16F18076 mounted on the board.

Tip: Solder 0Q resistors across the footprints or short circuit them with solder to reconnect the signals
between the on-board debugger and the PIC16F18076.

Connecting to External Microcontrollers

The figure and table below show where to connect the programming and debugging signals to program and debug
external microcontrollers. The on-board debugger can supply power to the external hardware or use an external
voltage as a reference for its level shifters. Read more about the power supply in 3.3. Power Supply.

The on-board debugger and level shifters actively drive data and clock signals used for programming and debugging
(DBGO, DBG1, and DBG2). Pull-down resistors are required on the ICSP™ data and clock signals to debug PIC®
microcontrollers. All other interfaces are functional with or without pull-up or pull-down resistors.

DBG3 is an open-drain connection and requires a pull-up resistor to function.

PIC16F 18076 Curiosity Nano has pull-down resistors R204 and R205 connected to the ICSP data and clock signal
(DBGO and DBGH1). There is also a pull-up resistor R200 connected to the MCLR signal (DBG3). The location of pull
resistors is shown in 7.2. Assembly Drawing in the appendix.

- Remember:
l::___.-'_' » Connect GND and VTG to the external microcontroller
» Tie the VOFF pin to GND if the external hardware has a power supply

» Make sure there are pull-down resistors on the ICSP data and clock signals (DBGO and DBG1) to
support the debugging of PIC microcontrollers
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Figure 3-10. Curiosity Nano Standard Pinout
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Table 3-4. Programming and Debugging Interfaces

DBGO UPDI DATA SWDIO
DBG1 — CLK SWCLK
DBG2 — — —

DBG3 — MCLR RESET

Connecting External Debuggers

Even though there is an on-board debugger, external debuggers can be connected directly to the PIC16F18076
Curiosity Nano to program/debug the PIC16F18076. When not actively used, the on-board debugger keeps all the
pins connected to the PIC16F18076 and board edge in tri-state. Therefore, the on-board debugger will not interfere
with any external debug tools.

© 2023 Microchip Technology Inc. User Guide DS50003399B-page 21
and its subsidiaries



PIC16F18076 Curiosity Nano

Curiosity Nano

Figure 3-11. Connecting the MPLAB® PICkit" 4 In-Circuit Debugger/Programmer to PIC16F18076 Curiosity

Nano
1=MCLR
MPLAB® PICkit™ 4 |2=vop
3 = Ground
4=PGD
5=PGC
6 = Unused
7 = Unused
v j 8 = Unused
le[7[es[+[3]2]1]
MCLR
VoD
Ground
CLOCK DATA
DEBUGGER
| DBG2 _ouud—® curiosTYNANO @—Copuy VTG Ry

A CAUTION The MPLAB® PICkit" 4 In-circuit Debugger/Programmer can deliver high voltage on the MCLR pin. High
voltage can permanently damage R110. If R110 is broken, the on-board debugger cannot enter the
programming mode of the PIC16F 18076 and will typically fail at reading the device ID.

A CAUTION To avoid contention between the external debugger and the on-board debugger, do not start any
programming/debug operation with the on-board debugger through MPLAB® X IDE or mass storage
programming while the external tool is active.
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4. Hardware Description

4.1 Connectors

411 PIC16F18076 Curiosity Nano Pinout

All the PIC16F 18076 1/O pins are accessible at the edge connectors on the board. The image below shows the board
pinout.

Figure 4-1. PIC16F18076 Curiosity Nano Pinout
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shown at specific pins to comply with the Curiosity Nano Board standard. These signals can usually be

ﬂ Info: Peripheral signals shown in the image above, such as UART, I2C, SPI, ADC, PWM, and others, are
routed to alternate pins using the Peripheral Pin Select (PPS) feature in the PIC16F18076.
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4.1.2 Using Pin-Headers
The edge connector footprint on PIC16F18076 Curiosity Nano has a staggered design where each hole is shifted 8
mil (~0.2 mm) off-center. The hole shift allows regular 100 mil pin-headers to be used without soldering on the board.
The pin-headers can be used in applications like pin sockets and prototyping boards without issues once they are
firmly in place.

Figure 4-2. Attaching Pin-Headers to the Curiosity Nano Board
[
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Figure 4-3. Connecting to Curiosity Nano Base for Click boards
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Tip: Start at one end of the pin-header and gradually insert the header along the length of the board.
Once all the pins are in place, use a flat surface to push them in.

Tip: For applications where the pin-headers will be used permanently, it is still recommended to solder
them in place.
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Important: Once the pin-headers are in place, they are hard to remove by hand. Use a set of pliers and
carefully remove the pin-headers to avoid damage to the pin-headers and PCB.

Peripherals

LED

One yellow user LED is available on the PIC16F 18076 Curiosity Nano board. It can be controlled by either GPIO or
PWM. Driving the connected 1/O line to GND can also activate the LED.

Table 4-1. LED Connection

PIC16F18076 Pin m Shared Functionality

RA1 Yellow LEDO Edge connector

Mechanical Switch

The PIC16F 18076 Curiosity Nano board has one mechanical switch - a generic user-configurable switch. Pressing it
will connect the 1/0 pin to ground (GND).

Tip: There is no externally connected pull-up resistor on the switch. Enable the internal pull-up resistor on
Pin RAO to use it.

Table 4-2. Mechanical Switch

PIC16F18076 Pin Shared Functionality

RAO User switch (SWO0) Edge connector, On-board debugger

32.768 kHz Crystal

On the PIC16F18076 Curiosity Nano board, a VMK3-9001-32K7680000 32.768 kHz crystal is mounted. The crystal is
accurate to within 20 ppm.

Important: The oscillator circuit is designed and verified for use with the SOSC in High Power mode.

The 32.768 kHz crystal is connected to PIC16F18076 pin RCO and RC1, which are also routed to the edge connector
through two solder points. RCO and RC1 are disconnected from the edge connector by default to reduce the chance
of an external signal causing contention with the crystal and to remove excessive capacitance on the lines.

The crystal has a cut-strap (J211) next to it that can be used to measure the oscillator safety factor. This is done by
cutting the strap and adding a 0402 SMD resistor across the strap. More information about oscillator allowance and
safety factor can be found in the AN2648 application note from Microchip.

The cut straps and solder points can be seen in Crystal Connection and Cut Straps.

Table 4-3. Crystal Connections

PIC16F18076 Pin m Shared Functionality

RCO SOSCO (Crystal output) Edge connector
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........... continued
PIC16F18076 Pin m Shared Functionality
RCA1 SOSCI (Crystal input) Edge connector

Some hardware modifications are required to use RC0O and RC1 as GPIO.

Before performing any hardware modifications, ensure that the board is disconnected from the USB or
external power.

/MA\WARNING

» Disconnect the crystal footprint by cutting the two straps on the top side of the board next to the crystal (J209,
J210). The footprint must be disconnected if a crystal is mounted to prevent damage to the crystal.

» Connect the I/O lines to the edge connector by placing solder blobs on the circular solder points marked RCO
and RC1 on the bottom side of the board (J207, J208)

Figure 4-4. Crystal Connection and Cut Straps
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Crystal

N
A
I

)

W

Top Side Bottom Side

On-Board Debugger Implementation

PIC16F 18076 Curiosity Nano features an on-board debugger that can be used to program and debug the
PIC16F18076 using ICSP. The on-board debugger also includes a virtual serial port (CDC) interface over UART
and debug GPIO. MPLAB® X IDE can be used as a front-end for the on-board debugger for programming and
debugging. MPLAB Data Visualizer can be used as a front-end for the CDC and debug GPIO.

On-Board Debugger Connections

The table below shows the connections between the target and the debugger section. All the connections between
the target and the debugger are tri-stated when the debugger is not using the interface. Hence, there are few
contaminations of the signals, e.g., the pins can be configured to anything the user wants.

For further information on how to use the capabilities of the on-board debugger, see 3.1. On-Board Debugger
Overview.

Table 4-4. On-Board Debugger Connections

PIC16F18076 Debugger Pin “ Shared Functionality
Pin

CDC TX EUSART[1/2] RX (PIC16F18076 RX | Edge connector
line)
RB4 CDC RX EUSART[1/2] TX (PIC16F18076 TX  Edge connector
line)
RB7 DBGO ICSPDAT Edge connector
RB6 DBG1 ICSPCLK Edge connector
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........... continued
PIC16F18076 Debugger Pin Shared Functionality
Pin
DBG2 SWO0/GPIO Edge connector
RE3 DBG3 MCLR Edge connector
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Hardware Revision History and Known Issues

Hardware Revision History and Known Issues

This user guide provides information about the latest available revision of the board. The following sections contain
information about known issues, a revision history of older revisions, and how older revisions differ from the latest
revision.

Identifying Product ID and Revision

There are two ways to find the revision and product identifier of the PIC16F 18076 Curiosity Nano: Either by utilizing
the MPLAB X IDE Kit Window or by looking at the sticker on the bottom of the PCB.

The Kit Window will pop up when connecting PIC16F18076 Curiosity Nano to a computer with MPLAB X IDE
running. The first six digits of the serial number, listed under kit information, contain the product identifier and
revision.

Tip: If closed, the Kit Window can be opened in MPLAB X IDE through the menu bar Window > Kit
Window.

The same information is found on the sticker on the bottom side of the PCB. Most boards will have the identifier and

7]

revision printed in plain text as AO9-nnnn\rr, where “nnnn” is the identifier and “rr” is the revision.

The serial number string has the following format:

"nnnnrrssssssssss”
n = product identifier

r = revision

s = serial number
The product identifier for PIC16F 18076 Curiosity Nano is A09-3454.

Revision 4
Revision 4 has a Microchip VMK3-9001-32K7680000 9 pF crystal mounted on the 32.768 kHz crystal footprint.

Revision 3
Revision 3 is the initially released board revision.

Revision 3 does not have a crystal mounted to the 32.768 kHz footprint.
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Document Revision History

N S T

B 02/2023 New hardware revision
A 09/2022 Initial document release
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Schematic

Figure 7-1. PIC16F18076 Curiosity Nano MCU Schematic
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Schematic

Figure 7-2. PIC16F18076 Curiosity Nano Debugger Schematic
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7.2 Assembly Drawing
Figure 7-3. PIC16F18076 Curiosity Nano Assembly Drawing Top

arr N

Ci04 = R103C102 Riog 2100
8 8= = I @ 88
S S LUl up2 88 © 8 ) Jiol
L 8E oo & 3 x o
& o (103 &
cator E& o Ut07 < g o
o o 9 o o
] agllllf 3 Uutos U200 203 S ] %% S
] o S 8 9
s 8 U105 J210§ (a4~ >
uteo % pio2 & 8211
2 N d
3 U104 %
D100 Ri1ZRiOZCIO6CIO7 U103 8

N /

Figure 7-4. PIC16F18076 Curiosity Nano Assembly Drawing Bottom

4 N

J202

J206
LABEL1 pegs G255 J102

J207
J204

J201
J203

TP101L
TP100

© 2023 Microchip Technology Inc. User Guide DS50003399B-page 33
and its subsidiaries



ty Nano
Appendix

10S1

PIC16F18076 Cur

™

Curiosity Nano Base for Click boards

7.3

Figure 7-5. PIC16F18076 Curiosity Nano Pinout Mapping
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Disconnecting the On-Board Debugger
The on-board debugger and level shifters can be completely disconnected from the PIC16F18076.

The block diagram below shows all connections between the debugger and the PIC16F18076. The rounded boxes
represent connections to the board edge. The signal names shown are also printed in silkscreen on the bottom side
of the board.

To disconnect the debugger, cut the straps shown in Figure 7-7.

programming, debugging, and data streaming. Cutting the power supply strap will disconnect the on-board

n Attention: Cutting the GPIO straps to the on-board debugger will disable the virtual serial port,
power supply.

Tip: Reconnect any cut connection by using solder. Alternatively, mount a 0Q 0402 resistor.

3

Tip: When the debugger is disconnected, an external debugger can be connected to holes, as shown in
Figure 7-7. 3.6. Connecting External Debuggers describes how to connect an external debugger.

s

Figure 7-6. On-Board Debugger Connections Block Diagram
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LDO g £
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Figure 7-7. On-Board Debugger Connection Cut Straps
( GPIO straps (bottom Side)) ( Power Supply strap (top side) j
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Microchip Information

The Microchip Website

Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

* Product Support — Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

* General Technical Support — Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

« Business of Microchip — Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service

Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

» Distributor or Representative

* Local Sales Office

»  Embedded Solutions Engineer (ESE)
» Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip products:

* Microchip products meet the specifications contained in their particular Microchip Data Sheet.

» Microchip believes that its family of products is secure when used in the intended manner, within operating
specifications, and under normal conditions.

» Microchip values and aggressively protects its intellectual property rights. Attempts to breach the code
protection features of Microchip product is strictly prohibited and may violate the Digital Millennium Copyright
Act.

* Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code
protection does not mean that we are guaranteeing the product is “unbreakable”. Code protection is constantly
evolving. Microchip is committed to continuously improving the code protection features of our products.

Legal Notice

This publication and the information herein may be used only with Microchip products, including to design, test,
and integrate Microchip products with your application. Use of this information in any other manner violates these
terms. Information regarding device applications is provided only for your convenience and may be superseded
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by updates. It is your responsibility to ensure that your application meets with your specifications. Contact your
local Microchip sales office for additional support or, obtain additional support at www.microchip.com/en-us/support/
design-help/client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY

OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE,
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR ITS USE
WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR
THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the buyer agrees
to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights
unless otherwise stated.
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Quality Management System

For information regarding Microchip’s Quality Management Systems, please visit www.microchip.com/quality.
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